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1K Xmodem

A 1024 byte packet, error-correcting protocol similar to Ymodem, except that it can only transfer one
file at a time.



ADM 3A

The emulation that supports the Lear Siegler terminal.



American National Standards Institute (ANSI)

The principal standards development organization in the United States. ANSI provides standards for
communication software such as WinFax and WinComm.



answer mode

WinComm'’s ability to handle incoming calls. Also known as host mode.



application

See program.



Application Program Interface (API)

A set of software calls used by an application to reference underlying network services.



American Standard Code for Information Interchange (ASCII)

An abbreviation for American Standard Code for Information Interchange. This standard code consists
of 7 data bits (or binary values) per character. Letters, numbers, and special characters (for example,
$.V,#, %) are represented by different ASCII codes. The ASCII character set represents 96 printable
characters and 32 non-printable control characters.



archive

Files containing other files. Usually, files in an archive have been zipped, or compressed.



asynchronous

A method of communicating characters between computers. With asynchronous communication,
characters can be sent without special coordination or control characters. Contrast with synchronous.



asynchronous adapter

A type of communications port.




asynchronous transmission

A transmission method in which time intervals between transmitted characters may be unequal.
Transmission is controlled by start and stop bits on each character, instead of clocking as in
synchronous transmission.




AT commands

Commands issued to your modem while in command mode. Refer to your modem documentation for a
complete list of AT commands.



auto answer

A program’s ability to answer incoming calls and establish a connection without user intervention.



autodial

A modem feature that allows users to dial telephone numbers without using a telephone. Commands
for dialing can be manually entered from the computer keyboard or automatically issued by a
communications program.



Backscroll Buffer

A special area of your computer's memory that contains a read-only image of the data scrolled off the
terminal screen. WinComm displays the Backscroll Buffer above the terminal area in the session

window.



baud

A unit of transmission speed. The speed in baud represents the number of discrete signaling elements
transmitted in one second. Most modern modems transmit at 2400 baud.



blurring

Effect applied to smooth an image by removing the hard edges.



Bulletin Board System (BBS)

A computerized meeting and announcement system that allows people to carry on discussions, upload
and download files, and make announcements without the people being connected to the computer at

the same time.



binary

A numbering system that is used by computers for storage of data. Binary numbers are stored as a
series of Os and 1s. Each 0 or 1 is referred to as a bit.



bit

The smallest unit of information used by computer systems. A bit is either on or off and represents the
values 1 or 0, respectively. A series of 8 bits is called a byte. ASCII characters are represented as one
byte.



bitmap (BMP)

An image formed by patterns of small screen dots (pixels), created by Microsoft. Some bitmap images
are compressed with an RLE type compression.



bits per second (bps)
A measure of data transmission speed.



block transmission

A method in asynchronous communications of breaking up data into discrete packet lengths for error
checking and acknowledging received data.



buffer

A device for temporary data storage. By offloading data to a buffer, slower devices are still able to
accept incoming data.



byte

Eight bits, which are treated as one unit of information. In your computer, numbers and characters are
represented as bytes.



carrier

A continuous signal, modulated with a second, information carrying signal.



Carrier Detect (CD) signal

Carrier Detect (CD) is an RS-232 signal from a modem to a computer, indicating that the modem has
made a connection with a remote system. Also known as Data Carrier Detect (DCD).



cascade

To resize and layer open windows so that each title bar is visible.



character

A standard 8-bit unit representing a symbol or letter. Also known as a byte.



character length

Also called data bits or bits per character, this is the number of bits required to represent a character.
Standard ASCII characters have a character length of 7 bits.



checksum

A method of error checking that is sometimes used in Xmodem and other file transfer protocols. A
checksum is calculated by both the sending and receiving systems. The sending system transmits its
calculated number. If the checksum received differs from the receiving system's calculated number, it
requests retransmission of the block.



Clear To Send signal (CTS)

Clear To Send (CTS) is an RS-232 signal from a modem to a computer that indicates the remote
system is ready to receive data.



communications protocol

The rules governing the exchange of information between modems or other communication devices.



compiling

The process of converting a human-readable version of a program into a machine-readable version
that a computer can execute.



COM port

Serial communications port. A port is the physical connection through which data is transferred to and
from a modem. COM1, COM2, COM3 and COM4 are port names used to represent physical devices
on your computer.



compression

The process of reducing the total size of data by converting it to a more compact format. WinComm
uses data compression whenever possible to transfer files in the least amount of time.



CompuServe B+ protocol

A communications protocol, most commonly used by the CompuServe Information Service. This
protocol supports error correcting and both single and multiple file transfers.



configuration

A computer’s software or hardware setup.



connect time

A measure of system usage: the interval during which the user is online for a session.



connection

A physical link that supports communication between two computers.



contention

A first come, first served method of access used with Private Branch Exchange phone systems in
which multiple devices must access a limited number of communications ports.




control characters

Non-printing characters used to stop, start or modify a function.



Cyclic Redundancy Check (CRC)

Cyclic Redundancy Check (CRC) is the preferred method of error checking used in Xmodem and other
file transfer protocols. A CRC is calculated by both the sending and receiving systems. The sending
system transmits its calculated number. If the CRC received differs from the receiving system's
calculated number, it requests retransmission of the block.



data bits

The number of bits, usually 7 or 8, in a data word that contain data. See also start bits, parity, and stop
bits.



Data Carrier Detect signal (DCD)

See Carrier Detect signal.




data communications equipment (DCE)

Data Communications Equipment (DCE) identifies the specific type of RS-232 port that is commonly
found on peripheral equipment such as modems. Contrast with Data Terminal Equipment (DTE).



data integrity

A measure of data communications performance, indicating the number of errors in a given
transmission.



Data Set Ready (DSR)

Data Set Ready (DSR) is an RS-232 signal from a modem to a computer indicating that the data set
(modem) is ready to communicate.



Data Terminal Equipment (DTE)

Data Terminal Equipment identifies the specific type of RS-232 port that is commonly found on
personal computers and terminals. Contrast with Data Communications Equipment (DCE).



Data Terminal Ready signal (DTR)

Data Terminal Ready (DTR) is an RS-232 signal from a computer to a modem indicating that the data
terminal (computer) is ready to receive data. It is used to force the modem to disconnect (hang up)

from a remote system.



data word

The combination of start bits, data bits, parity bits, and stop bits is called the data word. One data word
is used to represent each character of transmitted data.



Dynamic Data Exchange (DDE)

The form of interprocess communications used by Microsoft Windows to support command and data
exchange between two programs at the same time. Using DDE links, WinFax can communicate and

extract information from PIMs.



Delrina Basic

The WinComm scripting language. Programs can be written in Delrina Basic to automate common
WinComm tasks.



destination address

The destination to which a data packet is sent.



dialup
A temporary connection between computers established over a telephone line using modems.



download

The process of receiving a file from another computer. Contrast with upload.



drag and drop

The action of moving a file from one location on a desktop to another by selecting the file, and
dragging it to a new location. In WinComm, drag and drop can be used to automate file transfers.



driver

Software used to control hardware devices such as scanners, printers and modems.



dumb terminal

A display terminal with no processing capabilities. For processing, the terminal must rely on the
computer with which it is communicating.



echo

The process whereby a computer sends back a duplicate of each received character to the computer
that sent the character. In communications with most remote, dial-up systems, characters you type on
your keyboard will be echoed back to you by the remote system.



electronic mail (email)

A system of using electronic communications media to send and receive messages.



embossing

Effect applied to an image to create a three-dimensional, raised-relief look.



emulator

To enable a computer to simulate the behavior of a terminal.



ENQ

Enquiry. A control character used as a request to obtain status information.



error detection

The ability to detect errors during file transmission.



extracting

Decompressing, or unzipping a file



event

A record or description of a logon, logoff, send or receive occurrence. The record or description of the
event may include the date and time and other details.



file extension

The end portion of a file name, after the last dot, indicating the kind of data stored in the file. For
example, the file name resume.txt is an ASCII text file.



flow control

A means by which a computer or device that is receiving data can command the computer or device
that is sending the data to suspend and resume sending. Typical means of flow control are XON/XOFF
and hardware handshaking.



folder

A means of organizing files into a category. In previous versions of WinComm, folders were called
directories.



full duplex

A mode of communications whereby characters you type are sent directly to the remote computer
without first being displayed on your screen. The characters display on your screen only after the
remote system has sent an echo of the characters back to you.



global defaults

Global defaults apply to all sessions in your phonebook. If you change any setting from the Global
Defaults dialog, this change affects all sessions.



gray scale

Converting to gray scale transforms color images into monochrome. Each color is changed to a shade
of gray.



ground signal (GND)

Ground signal (GND) is an RS-232 signal that serves as a signal ground between a computer and a
modem.



GUI

Graphical User Interface. An operating system or environment which displays program choices and
information graphically. Windows is an example of a GUI.



half duplex

A mode of communications whereby characters you type are displayed on your screen as they are
being sent. The remote computer does not echo characters you type when you are using half duplex.



halftone

Converting to halftone transforms color images into black and white images normally used for faxing.



hardware handshaking

A process by which a computer uses lines in the RS-232 cable, in addition to those that carry serial
data, to indicate to another computer when it is ready to accept data.



host mode

The WinComm mode which allows other users access to your PC.



host system

A computer or computer service (other than the one on which you are running WinComm) with which
you can establish a connection and exchange data. It accepts calls and responds to commands that
the caller types on a terminal or on a computer that is acting as a terminal. Sometimes known as

Remote system.



HyperProtocol protocol

A fast, error-free, streaming file transfer protocol.



IBM 3101

A terminal emulator for use with IBM 3101 type mainframes.



IBM 3278

A terminal emulator for use with IBM 3278 type mainframes



icon

A “picture” that is a graphical representation of various Windows elements.



Image Manager

A WinComm component you can use to view, print and edit image files.



image noise

Speckled effect often created by the scanning or faxing process.



Integrated Services Digital Network (ISDN)

Integrated Services Digital Network (ISDN) is a digital transmission technology that enables voice and
high-speed data communications to be multiplexed on a single telephone line.



Internet

An “internet” (lowercase i) is a collection of networks linked by a set of routers which allow them to
function as a single, large virtual network. The Internet (uppercase |) is the largest internet in the world
made up of large national backbone nets as well as regional and local campus networks all over the

world.



/10
Input/Output.



Kermit protocol

A widely supported error correcting protocol, capable of downloading and uploading file groups.



KiloByte (KB)

A standard measurement for disk and memory storage. One KiloByte of memory equals 1024 bytes of
computer memory.



Link Access Procedures for Modems (LAPM)

Error control protocol ensuring data integrity.



log on

Type a user identification and password as necessary to gain access to a computer system.



logon

The activity of logging on, or the information you type when logging on.



macro

An automatic sequence that issues multiple keystrokes or characters when you enter a single
keystroke or key combination.



Messaging Application Programming Interface (MAPI)

Microsoft's system for sending email across a local area network.



modem

A device used to convert computer data into a form that can travel through telephone lines (convert
digital to analog signals). It is an abbreviation for MOdulator - DEModulator.



mosaic

Effect applied to an image to create a tiled version of the image.



network

A computer system in which resources are shared among multiple computers.



nibble
The first or last half of a an 8-bit byte (4 bits).



node

Any network device that has an address on the network.



null modem cable

An RS-232 cable that allows the DTE ports of two computers to be directly connected to each other.



Object Linking and Embedding (OLE)

A technology developed by Microsoft to allow Windows users to incorporate text and objects from
other programs into their current document. For more information, refer to your Microsoft Windows
User's Guide.



offline

A term describing a computer that is not connected to another for the purpose of communications.
Contrast with online.



online

A term describing a computer that is connected to another computer for purposes of communications.
Contrast with offline.



packet
A sequence of data, with associated control information, that is switched and transmitted as a whole.



pad characters

Place holders required to adhere to a specific data structure.



parallel port

An access point through which a computer transmits or receives data that consists of several bits sent
simultaneously on separate wires. Contrast with serial port.



parity

A bit having a value of 0 or 1 that is added to a character as the character is sent. The receiving
system can use the parity bit as a means of detecting errors in the character. The parity bit added
makes the sum of bits in a data word either an odd number (for odd parity) or an even number (for
even parity).



password

A word or group of characters a user must enter to gain access to a computer, system or files.



PBX (Private Branch Exchange)

A telephone system used by many offices that provides extensions for each telephone, and a
connection to the main telephone system.



peripheral device

A device connected to a computer to supply input to and/or accept output from the computer.



phonebook

An online directory of remote systems accessed through WinComm. You can connect to a remote
system by double clicking on any icon in the phonebook.



phonebook entry

A phonebook entry defines connection parameters for a remote system. For example, each
phonebook entry specifies communications port, modem, parity, etc. It can also define a phone
number. Phonebook entries have a system name, a file name, and an icon. Using the View menu, you
can choose to display some or all phonebook entries in the Phonebook window. You can also choose
to display icons, system names, file names, or other information about phonebook entries.




pixel

The smallest picture element that can be displayed on your screen.



plug and play

Hardware or software that, after being installed (“plugged in”), can immediately be used (“played
with”), as opposed to hardware or software which requires configuration.



posterizing

Effect applied to an image to remove color gradations and create areas of solid colors or gray shades.



prefix

Codes required by your phone system to obtain an outside line. For example, “9,” means dial “9”, and
pause for an outside line.



program

A computer application you interact with or use to perform a task or function, such as word
processsing, spreadsheet, accounting, electronic mail or communications software.



protocol

A system of rules and procedures governing communications between two or more devices. Protocols
vary, but communicating devices must use the same protocol in order to exchange data. The format of
the data, readiness to receive or send, error detection, and error correction are some of the operations

that may be defined in protocols.



pulse dialing

An older form of telephone dialing, utilizing breaks in current to indicate the number dialed. Contrast
with tone dialing.



quoting

A method in asynchronous communications of breaking up data into discrete packet lengths for error
checking, and acknowledgment of received data.



Random Access Memory (RAM)

Memory in which data is temporarily stored for processing.



remote access

The ability of a computer in one location to connect with a computer at a different location. The most
common methods of remote access are through a network or by modem.



Receive Data signal (RD)

Receive Data (RD) is an RS-232 signal that carries data from a modem to a computer.



remote system

A computer or computer service (other than the one on which you are running WinComm) with which
you can establish a connection and exchange data. A remote system accepts calls and responds to
commands that the caller types on a terminal or on a computer that is acting as a terminal. Sometimes
known as host system.



Request To Send signal (RTS)

Request To Send (RTS) is an RS-232 signal from a computer to a modem that indicates the computer
has data to send to a remote system.



right click

To click the right mouse button. In WinComm, right clicking in the Phonebook and Session window
brings up a context-sensitive right click menu.



right click menu

A context-sensitive menu in WinComm displayed by placing the mouse pointer on a particular area of
the screen and clicking the right mouse button.



ring indicator signal

Ring Indicator (RNG) is an RS-232 signal from a modem to a computer indicating that the telephone is
ringing. Sometimes called ring detect.



Routing Information Protocol (RIP)

A protocol used by routers on a LAN to exchange routing information amongst participating routers.



RIPscrip

RIPscrip is a terminal emulation that displays a GUI type, mouse click interface rather than the
standard text based emulations currently supported in WinComm.



RPI

Rockwell Protocol Interface. A cost cutting feature of some modems, allowing compression and error
correction to be handled with software, instead of hardware.



RS-232

Recommended Standard 232. RS-232 is a serial port standard of The Electronics Industries
Association (EIA), orginially designed as an interface between a computer/terminal and a modem.



RS-232 cable

A standard type of cable to ensure uniformity of interfacing signals between two computers and/or
peripherals. RS-232 cables typically plug into male or female 9-pin or 25-pin D sockets on your
computer, modem, or other peripheral devices.



Scratch Pad

A special area at the bottom of a session window that can be used to create and manipulate text.



script editor

A WinComm component for editing, debugging and compiling scripts.



serial port

A connector on a computer to which you can attach a serial line connected to peripherals which
communicate using a serial (bit-stream) protocol. A RS-232 cable attaches to serial ports. See also

COM port.



session

One instance of a connection to a remote system. For example, while you are logged on and reading
messages, posting items or uploading or downloading files, you are in a session.



sign on

WinComm uses the terms log on and logon, in place of sign on and sign-on.



software handshaking

A method by which a system that is receiving data can send control characters to the computer that is
sending, to indicate when it is ready to receive data.



start bits

Bits added to the beginning of a data character (see data bits) during asynchronous communications.



stop bits
Bits added to the end of a data character (see data bits) during asynchronous communications.



streaming

A method of data transmission that permits the sending system to transmit data until all of it is sent, or
until the sending system receives a negative acknowledgment from the receiving system. Upon receipt
of a negative acknowledgment, the sending system automatically retransmits the failed block and all
subsequent blocks.



subfolder

A lower-level folder that you create beneath a top-level folder for organizing and storing files. In
previous versions of WinComm, subfolders were called subdirectories.



synchronous

A method of character communication between modems. With synchronous communication, the two
modems coordinate transmission using special control character sequences. See asynchronous.



synchronous transmission

A type of data transmission in which characters and bits are transferred at a fixed rate, with the
transmitter and receiver synchronized by a clock source. Stop and start bits are not needed.




system

In WinComm, a computer you can communicate with via modem, cable, or other communications
device.



system list

The directory of remote systems that appear as WinComm phonebook entries.



Telephony Application Program Interface (TAPI)

A Windows programming interface allowing access to personal telephony features like speech and
data transmissions and voice mail.



teletype

A Teletype (TTY) terminal is the simplest type of terminal and is compatible with most remote systems.
Data appears on its screen one line at a time.



telnet

A terminal protocol that allows users of one system to log on to remote hosts and perform as normal
terminal users of that host.



terminal

A device consisting of keyboard and screen that can be connected to a host computer to allow you to
operate the host computer. Typically, the function of communications software is to make your
computer act like, or emulate, a terminal.



terminal display

The terminal display is the portion of the session window where interaction with the remote system
takes place. By default, the terminal area is surrounded by a frame. This frame can be removed by
clicking Frame on the View menu.



terminal emulation

A feature that allows a computer to mimic the behavior of different types of terminals.



Terminate but Stay Resident program (TSR)

Also known as “memory resident” programs. TSRs always stay in a computer’s memory and can be
activated by a keystroke.



tile

To resize and arrange all open program windows side by side.



tone dialing

A modern form of telephone dialing, where each number has a distinctive tone. Also known as Dual
Tone Multiple Frequency (DTMF).



toolbar

A screen component used to display command buttons which activate menu commands or tool buttons
which activate individual tools.



transmit data (TD) signal

Transmit Data (TD) is an RS-232 signal that carries data from a computer to a modem.



TTY

A terminal emulator used by teletype machines.



TV925

The terminal program used to emulate Televideo 925 systems.



TV950

The terminal program used to emulate Televideo 950 systems.



UART

Uniform Asynchronous Receiver/Transmitter. An integrated circuit used for serial communications,
containing a transmitter and a receiver.



upload
The process of sending a file to another computer. Contrast with download.



virus

A destructive, self-replicating program. Viruses often disguise themselves by embedding in program
executables. Some viruses are harmless, while others are quite destructive.



Virus Checker

A WinComm feature allowing downloaded files to be scanned for viruses.



VT52, VT100, VT102, VT220, VT320

Terminal programs used to emulate DEC Vixxx terminals.



Wang

The terminal program used to communicate with a Wang minicomputer that is equipped with an ADC
or EADC protocol converter.



.WCS

WinComm Session files.



wave file

Sound files with the extension .WAV. In WinComm, you can use a .WAV file to notify you when
different events are complete.



windowed transmission

A method of data transmission that sends one or more packets and then waits for acknowledgment
from the receiving system. The opposite of streaming.



Winsock

Short for Windows Sockets. A TCP/IP stack used by Windows to communicate with a network.



Xmodem protocol

Xmodem is the most commonly used name for an error-free file transfer protocol. In this protocol, data
is transferred as blocks along with error-checking codes. ASCII control characters are used to
synchronize the transfer.



XOFF/XON

A method of flow control or software handshaking used primarily during transfer of text or text-like
data.



Ymodem protocol

A 1024 byte packet, error correcting protocol capable of transferring single files or groups.



Zip Manager

A WinComm file compression and decompression utility, run from either the File menu or as a separate
program.



zoom

To enlarge or magnify an image view.



Zmodem protocol

Zmodem is an error-correcting, streaming protocol that has become popular on most bulletin boards.
Zmodem is capable of transferring both single files and file groups.



.BAT
Batch file, can be MS-DOS or UNIX in origin.



.COM
Command file, usually an MS-DOS file.



.EXE

Executable DOS/Windows program. Can also be a compressed, self-extracting MS-DOS executable.



WAV

Microsoft sound file. See also wave file.



.DOC

Micosoft Word document file. Can also be an ASCI| text file.



.CNT

Windows Help contents file. Usually associated with a .HLP file.



.HLP
Windows Help file. Usually associated with a .CNT file.



TIXT

ASCII text file.



.WPD

WordPerfect document file.



.CMP
LEAD image file. This file format is supported by Image Manager.



.EPS
Encapsulated PostScript file. This file format is supported by Image Manager.



.TGA
Truevision (Targa) file. This file format is supported by Image Manager.



ZIP
PKZIP compressed file.



.GIF
Graphic Interchange Format image file. This file type is supported by Image Manager.



IMG
GEM image file. This file format is supported by Image Manager.



JFIF
JPEG File Interchange Format image file. This file format is supported by Image Manager.



JPEG (.JPG)
JPEG image file. This file type is supported by Image Manager.



.PCD
Photo CD image file. This file format is supported by Image Manager.



.PCT
Macintosh PICTURE file. This file format is supported by Image Manager.



.PCX
PC Paintbrush image file. This file format is supported by Image Manager.



LEAD

A graphics file format supported by Image Manager.




.FXS

File extension for images created when you generate an attachment by printing to WinFax from
another program. This file type is supported by Image Manager.



.TIF
Tagged Image File image file. This file type is supported by Image Manager.



Delrina Dialing

A method of dialing Windows (TAPI) and Standard COM modems. With Delrina dialing, WinComm
dials directly, instead of releasing the call to Windows. Sessions using Delrina dialing use WinComm
prefixes, suffixes and credit card settings. Contrast with Windows dialing.




Windows Dialing

A method of dialing Windows (TAPI) modems. With Windows dialing, WinComm releases the call to
Windows, and the number is dialed using Windows prefixes, suffixes and credit card settings. Contrast

with Delrina dialing.



Legacy Settings

Initialization strings, which configure how a modem operates, used with previous (1.1 or earlier)
versions of WinComm.






